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Preview of SpecLink+
the future of BSD SpecLink

The current CD-ROM contains the beta
version of a brand new BSD SpecLink.
Although the product is not quite
complete, we wanted to give our current
subscribers a preview of the new 32-bit
version of SpecLink that will begin
distribution in the Spring of 2000.

The new user interface closely resembles
that of PerSpective™, the performance
specification system BSD developed for
the CSI/DBIA Joint Venture. In place of
the separate Project Window and Section
Window, the new software has an
Explorer-style navigation tree and a
Document Panel that can be open
simultaneously in a single window. The
Document Panel, which displays the
section text for the document selected
in the tree, was designed to be as
WYSIWYG as possible, resembling word

Brm b e Ty [ i i oy

Nl @0 R0~ AT 0.0 =P NSme e

A E-g Pl P i Ak, o]

processors like Word. Instead of a
separate Edit Panel, you now edit text
directly in the document, where you see
the full text of all paragraphs.

A single mouse click selects a section
in the tree or selects a paragraph in the
Document Panel. Grid lines designating
the individual paragraphs can be turned
off for faster operation, further increasing
the resemblance to a word processing
interface. Paragraphs in the section are
automatically numbered as text is
selected, or this feature can be switched
off to increase processing speed. Fonts
can be globally changed by text level, as
in the current product, but in the new
software you can select text and change
fonts within any paragraph, as well.
Embedded choices show up in color in
the Document Panel. Green text
indicates global
options like units of
measure, which
can be changed
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New WYSIWYG interface makes text review easy.

Winter 1999/2000

E Y2K at BSD

Worried about Y2K at BSD? Don't be.
The news articles are really heating up
about how some software programs will
not be able to handle dates after the year
2000. Some predict that all work done
on computers will come to standstill. We
are happy to report that with minor ex-
ceptions, described below, the BSD prod-
uct line will not be adversely affected by
dates later than 2000. The list below
notes certain areas in BSD products
where 2 digits date fields are currently
being used and what impacts you can
expect.

BSD SpeclLink - all versions:

- CD Effective Date — all dates in BSD
SpeclLink are stored in long number
format, meaning that the number
stored is the number of days since
January 1, 1900. This way the
software does not rely on interpreting
dates and date formats but instead
deals only with numbers.

Updated field — same as above
Report Date field - same as above

See YZK, page 2
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SpecLink+
continued from page 1

dialog box that allows you to change the
selected option. Fill-ins are indicated by
red brackets, and a single click within
the brackets blocks the underline and
allows you to type a replacement.

Because the text now appears more like
adocument in word processing (on a white
background), active text that will print no
longer is indicated by a change in back-
ground color from gray to white. Instead,
there are a number of cues that indicate
selected, active text. First of all, the X in
the status box of the current product has
been replaced by a checkmark to show
user selections (links still show up as
green, yellow, or red). The color of the
status columns changes from light to
dark gray when a selected paragraph is
active. If autonumbering is turned on,
paragraph numbers appear only at active
text. And finally, the light gray text of in-
active paragraphs turns to black when the
paragraph is active and will print.

Notes now appear in a separate, “float-
ing” window that can be moved and
resized. Clicking the Close button causes
the note to disappear, but a later click on
the Notes icon causes the window to re-
open in the same size and in the same
place you parked it. Separate Master and
Project note tabs in the Notes window
allow you to attach a note to any para-
graph without altering the master note.
You can also insert graphic files in a
Project note.

Another new feature is Compare Projects
(available from the Tools menu), which
allows you to compare any two versions
of a section, division, or project. The dif-
ferences are shown in the form of under-
lining for new text and strikethrough for
deleted text. This feature should be es-
pecially helpful for addenda. You can also
mark multiple sections for copying to a
different project.

Before you try out the beta version of the
new software, you should be aware that
a few features are still missing. Also,
although you can use the software to
create specifications for a project, any
work you do in this beta product may not
be compatible with the final, production
software. The beta software does not yet
include the requirements reports or an
automatic table of contents report,
although it does include Section 00100 —
Table of Contents, which is linked from
all other sections in the database. You
will not be able to insert choices or add
links, although these features will be
included in the final product. And you will
not be able to add new sections although
this feature will also be included in the
final product.

We urge you to try out the future of BSD
SpecLink and send us your feedback.
Our current plan is to introduce the initial
version of the final product on the Spring
2000 CD-ROM. For at least the next year,
we will deliver both versions each quar-
ter, and the 16-bit product will be phased
outin 2001.
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Notes to the specifier provide valuable infornation to help you make your selections.

CostLink/CM (M32)

What is the easiest way to add
overtime to my whole project?

Overtime can be added to any part

of your project by clicking on the
appropriate folder and opening the Mark-
ups dialog. If you want overtime applied
to the whole job, then switch to Single
Tab Mode (from the Tree Menu), click on
the topmost project folder, open the Mark-
ups dialog and switch to the Overtime tab.

| would like to see my estimate
sorted by the work to be done by
each subcontractor.

With CostLink/CM you can display

your estimate in a number of dif-
ferent views. Besides the primary Work
Breakdown Structure View, you can also
select Contractor View, Bid Schedule
View, or Activities View. This gives you
the ability to review and analyze estimate
costs in a multitude of ways. Simply
select a View or Query from the pulldown
directly under the estimate name.

Y2K
continued from page 1

BSD SpecLink will not be impacted by
the year 2000.

BSD CostLink/CM:
Date fields in Summary Information
— are for information only and do not
affect calculations.
Material Update date — is for
information only and does not affect
calculations.
Escalation Date fields — are
references for the escalation indices
and do not affect calculations.

BSD CostLink version 1.6:
Date fields in reports — are for
information only and do not affect
calculations.
Escalation Date fields — are




CostLink (MFW)

| have added a new contractor to

do metal fabrication work, and then
added overhead items for the running of
the fabrication shop, but they are not being
added to my estimate.

There are 4 different types of

markups for Overhead: P —which
is a percentage markup, D — which is a
percentage calculated from direct costs
only, A — which is an entered amount,
and C — which is calculated from the
overhead items entered under that
contractor’s Overhead title. Edit this
contractor’s record and change the
calculation type to C for those items to
be included in the estimate.

I'm getting a weird header on my
report.

There is a standard report header

and also a run-time report title
(especially helpful if you are printing an
intermediate report and want to make sure
everyone knows that the estimate is not
complete!) Select the Print option from
the File menu and remove the header from
the run-time report title field.

| would like to discount all the

material on my job by 8%. Do |
have to change the material unit on each
cost item?

No, you can use adjust pricing to

add or discount any cost in the
estimate. Change the Notes Panel view
to the Adjust Pricing screen using the
pulldown. You can adjust any portion of
your estimate but if you want all the prices
adjusted, first make sure the adjustment
is applied at the Project Level, then
simply enter the discount amount in the
material cost column. By entering a CSI
code such as 05 in the ID column, you
can limit the discount amount to only cost
items which fall in Division 05.

Which is the most efficient way to
copy items from the Unit Price
database into my estimate?

The drag and drop technique is

generally the fastest. Simply tile
the database and the project side by side,
highlight the item in the database, hold
down the mouse button and drag the item
to the project. This can be improved by
finding all the items in the database which
you will want under a particular project
title and putting the line item quantity in
that field in the database. When you have
marked all the items you want with their
respective quantities, click on the Copy
button and then Paste into the estimate.
All of the marked items will come along
for the ride.

| have created a new cost item in
the Unit Price database and used
itin an estimate. Every time | recalculate

references for the escalation indices
and do not affect calculations.

Database Listings (the Unit Price
Book, Crews, Labor or Equipment
listings) - currently allow the user to
filter the listing by update date. This
particular filter will not work with
dates greater than 2000, but you will
still be able to produce a database
listing report. Cost estimate
calculations are not impacted.

Composer Gold version 6.0:

- Date fields in reports — are for
information only and do not affect
calculations.

Escalation Date fields — are
references for the escalation indices
and do not affect calculations.

Database Listings (the Unit Price
Book, Crews, Labor or Equipment
listings) - currently allow the user to
filter the listing by update date. This
particular filter will not work with
dates greater than 2000, but you will
still be able to produce a database
listing report. Cost estimate
calculations are not impacted.

These responses are predicated on your
PC being able to recognize dates after
the year 2000. Older PC’s may not
recognize these dates, which may cause
sporadic problems in various programs.

Please contact BSD
Technical Support at
404-876-0052 if you have
any other questions.

my estimate, the equipment cost
changes from what | entered. It's driving
me crazy!

What you might not have noticed

is that when you created that item,
it inherited the crew and crew productivity
of its predecessor. If your estimate is an
A type estimate (for Auto-recalculation)
then itis repricing all line items using the
indicated labor and equipment rates
databases and the specified crew
composition. In your case it is finding
the crew ID on this line item and changing
the equipment unit cost to match. If you
want a simple unit cost for equipment,
wipe out the crew information on the item
form.

| want to get a report of the labor

used in my project, and | can see
it on my Report Setup screen, but it is
grayed out and | can't select it.

In order for CostLink to calculate

the labor (and equipment) needed
for those reports, your project must be
an A type estimate meaning that it
automatically recalculates the labor and
equipment costs each time reports are
run.

How do | put a lump sum cost on
atitle level?

See Q & A, page 6
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About your SpecLink Winter Update

BSD SpecLink Statistics:

121 existing sections updated (17 percent)
1 new non-proprietary section

16 new proprietary sections

425 non-proprietary sections total

286 proprietary sections total

710 sections total

New Section - Non-Proprietary:
14560 - Chutes (Gravity chutes for waste (trash), linen, and
recyclables)

New Sections - Proprietary:

02470 - Screw Piles and Anchors (A.B. Chance)

05532 - Trench Gratings (Balco)

05533 - Trench and Access Covers (Balco)

05551 - Stair Nosings (Balco)

05705 - Ornamental Metal Mesh Panels (Cambridge)

05810 - Expansion Joint Assemblies (Balco)

06139 - Timber Construction (Western Red Cedar Lumber
Assn.)

06151 - Cedar Decking (Western Red Cedar Lumber Assn.)

06221 - Wood Trim (Western Red Cedar Lumber Assn.)

06251 - Slatwall Paneling (Perma Groove)

07462 - Cedar Siding (Western Red Cedar Lumber Assn.)

10260 - Wall and Corner Guards (Balco)

11630 - Laboratory Glassware Washers/Decontaminators
(Lancer)

12484 - Floor Grid and Floor Mat Systems (Balco)

13966 - Total Flooding Extinguishing System (Fike)

15102 - Copper and Copper Alloy Building Services Piping
(Copper Development Assn.)

Renumbered Sections:

Although we try very hard not to renumber existing sections,
occasionally we have no choice. We apologize for any
inconvenience this may cause:

11611 - Self-Contained Filtered Laboratory Enclosures - Now
is numbered 11625

11612 - Biological Safety Cabinets - Now is numbered 11620

11613 - Laboratory Glassware Washers/Dryers - Now is
numbered 11630

Referenced Documents of 30 Organizations were
Verified in the Last Quarter:
Al The Asphalt Institute

ARRA Asphalt Recycling and Reclaiming Association
AWWA  American Water Works Association

CDA Copper Development Association

CGSB Canadian General Standards Board

CISCA Ceilings & Interior Systems Construction Asso.
DASMA Door & Access Systems Manufacturer’s Asso.

DHI Door and Hardware Institute
EIMA EIFS Industry Members Association

FS Federal Specifications and Standards

GA Gypsum Association

GANA Glass Association of North America

IAPMO International Association of Plumbing and
Mechanical Officials

IIAR International Institute of Ammonia Refrigeration

MBMA Metal Building Manufacturers Association

NCRP National Council on Radiation Protection and
Measurement

NFRC National Fenestration Rating Council

NLA National Lime Association

NOFMA national Oak Flooring Manufacturers
Association

NSF NSF International, Inc.

PDI Plumbing and Drainage Institute

SAE Society of Automotive Engineers

SIGMA Sealed Insulating Glass Manufacturers
Association

SPIB Southern Pine Inspection Bureau, Inc.

SWI Steel Window Institute

TPI Truss Plate Institute

VSI Vinyl Siding Institute

WCLB West Coast Lumber Inspection Bureau
WIC Woodwork Institute of California
WWPA Western Wood Products Association

Some notable new and updated documents include:

NFPA 13 - Standard for the Installation of Sprinkler Systems,
1999 (extensive additions)

NFPA 70 - National Electrical Code, 1999

NFPA 72 - National Fire Alarm Code, 1999 (completely
revised)

NFPA 204 - Guide for Smoke and Heat Venting, 1999 (new
calculation methods)

Some new codes that have been published recently:
BOCA National Building Code and Fire Prevention Code, 1999
SBCCI Standard Building Code and Fire Prevention Code, 1999
1999 Updates to the ICC International Plumbing, Private
Sewage Disposal, Fuel Gas, & Mechanical Codes.

CABO Model Energy Code has been superceded by the ICC
International Energy Code.

Specification and Design Information Sources:

Did you know that SpecLink subscribers are entitled to a copy
of BSD’s publication “Specification and Design Information
Sources™? This document is a printout of the latest information
we have on where to find information on reference standards,
codes, and design references. It includes the organization
name, address, phone number, fax number, and web URL for
over 200 trade associations, professional societies, government
agencies, and other non-governmental standards developing
organizations. If you want a current copy e-mailed to you, just
e-mail us at support@bsdsoftlink.com.




Automating Specification Writing and Management Using BSD SpecLink®

Why Depend on an Outside
Specification Service?

As most of our customers know, it is
almost impossible for any firm to keep
an office master up to date without
resorting to an outside master
specification service like MASTER-
SPEC® or SpecLink®. In any given year,
hundreds of changes occur in the
construction industry, and these changes
need to be reflected in construction
specifications. Subscribing to a
specification service reduces the amount
of time needed for routine maintenance
operations, significantly increasing the
amount of time available for design
professionals to do the kind of unique
product research that seems to crop up
on every project. With SpecLink, the
automated updating process is itself a
significant time-saver.

Other reasons for using an outside source
are to achieve improved project
coordination and overall document quality.
Perhaps the most important reason,
however, is that automation is a
prerequisite for linking specifications to
CAD, cost estimating, and other A/E/C
software applications, an opportunity
BSD has been pursuing for several years
now.

Why Use a Relational Database for
Specifications?

The traditional approach to automating
specifications is to insert special codes
into word processing files and to further
process the files using special software
routines. This approach is typified by
ARCOM'’s Linx™ product and the
SPECSINTACT program developed by
NASA and later adopted by the DOD. The
other automation technique is to organize
the specifications into a relational
database with word processing features.
Both BSD SpecLink and PerSpective use
the latter approach.

In both BSD SpecLink and PerSpective,
all data for a project is stored in a single
file, instead of in dozens or even hundreds
of word processing files. This single file
per project results in much better
coordination between the various
sections that make up the project
specifications, because the file structure
allows us to link easily from one section
to another. It also allows us to establish
preferences—for paragraph numbering

style and units of measure, for example—
in one place per project, instead of
repeating the information in many different
word processing files.

The most important advantage of BSD’s
relational database approach to
automation is the fact that all user
modifications are stored as an overlay to
the master data. What the user sees on
the computer screen is actually a merged
image of the master data as modified by
the project overlay file. This approach
means that the master data can never
be corrupted inadvertently by the user.
More importantly, it means that our
quarterly updates for SpecLink and semi-
annual updates for PerSpective can be
installed automatically without disturbing
project files. All user additions, edits,
notes, and links are unaffected by the
updating process.

Using BSD SpecLink and PerSpective
In both these specification programs,
editing is accomplished by selecting
project text from the master database,
instead of deleting it—the approach used
in word processing. Master text that is
not selected remains visible (although
grayed out) but is not included in the
project and therefore does not print. This
approach means that additional master
text can always be selected at a later
date for changing project conditions. It
also means that a specification section
originally developed for one project and
copied to another can be further
customized to the new conditions,
because all the master data remains
visible and available for selection.

Both SpecLink and PerSpective include
a separate Notes window that keeps in-
formation relevant to the master text avail-
able but out of the way. The master data-
base for each product contains many
thousands of notes, but users can add
their own project notes to master text or
to text they have added. In PerSpective,
the Notes window accepts graphic files
as well as text files. All of this
customization of text and notes is stored
in the project overlay file and is automati-
cally merged with the master database
when a project is viewed on the computer
screen.

What Are Links and How Are They Used?

In addition to text and notes, the BSD
SpecLink master database includes well
over 100,000 links. PerSpective includes
almost 25,000 links. What are they?
Essentially, a link is an instruction at-
tached to a particular text segment (a
paragraph, or an embedded choice within
a paragraph) that results in a change to
another text segment when the source
paragraph is selected, either directly by
the user or by another link. The links are
the means by which we add “intelligence”
to our database.

There are three kinds of links. We de-
scribe them as yes, no, and maybe, and
they are color-coded as green, red, and
yellow, respectively. Any paragraph may
be the target of dozens of links and the
source of dozens more.

Each time a paragraph with links is se-
lected and becomes active, all its links
are immediately activated. Green links
select other paragraphs that are needed
as a result of the initial selection. Yellow
links highlight possibilities the user may
wish to consider, and red links exclude
paragraphs that would be incompatible
with the initial selection.

The links may be within the same sec-
tion or between sections. For example,
products in Part 2 of SpecLink sections
frequently have links to installation in-
structions in Part 3 of the same section.
Cross references to other sections almost
always result in links to those other sec-
tions, so relevant information is automati-
cally selected or highlighted. Sometimes
selection of a single paragraph can re-
sult in selection of dozens, or even hun-
dreds of paragraphs elsewhere in the
database, due to a phenomenon we call
cascading. This is particularly true at
higher levels in the PerSpective database,
where the chapters are organized hierar-
chically.

Of course, the user always has the final
say in determining which text is included
in a project. Text excluded by a link can
be selected, and text included by a link
can be deselected by simply clicking on
its status box.

This article is excerpted from a seminar presented by Robert Paul Dean, AlA, CSI,
CCS, at CSI's National Convention in Los Angeles on June 25, 1999.




Q&A
continued from page 3

Go to that title and open the Item

Form. You will notice the unit cost
fields are unavailable to the cursor. The
cost totals are based on all cost items
below that title (the totals are zero if there
are no cost items) and the units are cal-
culated by dividing the totals by the title
guantity. Go to the Options Tab and put
a checkmark in the Cost Override box.
Now go back to the Costs Tab and see
that the fields are now available and you
can enter a lump sum cost, effectively
overriding the previous calculations.

SpecLink
E What does the .SAV file do?

The SAV file is a backup of the

project file from the last time it was
updated. This file is created before the
update is started in the remote chance
that something happens to your project
during the update process. Other file ex-
tensions of interest are: the SLP file which
is the project file, the LOG file which lists
all the latest master updates that are rel-
evant to your project, and the LDB file
which is used by the software for multi-
user locking.

How do | insert the degree symbol
in my text?

Windows includes a utility called

Character Map, which is generally
found under Accessories (if you can't find
it in your Start menu, look for the file
charmap.exe under the Windows direc-
tory). Open the Character Map and se-
lect Arial as the font. Locate the symbol
you want and highlight it. The keystroke
you need to add the symbol into your text
is displayed in the lower right-hand cor-
ner.

Is there a way to control where

SpecLink places a page break?
It's breaking right in the middle of a sen-
tence.

SpecLink works just like most

popular word processing pack-
ages. Select Widow and Orphan control
on the Print dialog to keep single lines
from appearing as the first or last line on
apage.

BSD SpecLink

1-1/2 day $395
December 20 - 21, 1999
January 24 - 25, 2000
February 28 - 29

March 27 - 28

April 24 - 25

May 22 - 23

June 19 - 20

Class attendees earn 12
Continuing Education Hours.
AIA Members earn 36
Learning Units (*Dec. class).

Year 2000 Software Training Schedule

You can now look for BSD class schedules on our internet site. Just go
to www.bsdsoftlink.com and go to the training page.
schedules, maps, hotel information, and information about Atlanta.

BSD CostLink/CM (M32)
4-1/2 days $1195
February 14 - 18, 2000
April 10 - 14

June 12 - 16

BSD CostLink (MFW)
3-1/2 days $895
January 10 - 13, 2000
March 20 - 23

May 8 - 11

Government Contractors
earn Mcaces Certification.

You will find

Is there a way to make the Notes
box larger so that | don’t have to
keep dragging the dividing line over?

After dragging the dividing lines to

the places you prefer, and making
any other layout selections, select the
Save Section Layout as Default option
from View menu.

For the firsttime | have to do a spec

on a small branch office of a local
bank. How do | set the Bank Branch
Model project provided on the CD to be
the source of my new project?

If this is a one-time job, then you

could simply copy the Bank
Branch model project to a new name (use
Copy Project from the File menu) and
start making the required edits. If you
want to set one of the model projects (or
a master project of your own) to be the
source of all new projects, then select
Project Setup from the File menu and
choose that project as the Project
Source.

How do | change the paragraph
numbering from 1.2 to 1.027?

Select the Paragraph Format op-

tion from the Format menu. You
can select one of the pre-defined format-
ting schemes or click on the button for
User-Modified. If you want to change the
formatting of level 2 paragraphs only, click
on the Modify button, select Level 2 in
the top pulldown, and then select the de-
sired number format (1,2,3...;
01,02,083,...; i,ii,iii,...; etc.).

I would like to add a special section
in what | call Division 17. Can I?

No, SpecLink does not allow new

sections in other than the standard
16 divisions. One workaround would be
to add the section into Division 16 and
change the title of the seaction to read
SECTION 17xxx. If youwantto have the
section number in the header or footer
you will have to “hard code” it rather than
using the @NUMBER keyword. That
means you will have to remember to treat
this section separately
and also to edit the Table
of Contents to conform
to your change.




